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Chapter 10 Using the Outline Editor

This chapter describes the basic functionality of the 
GoLive CyberStudio Outline Editor, explains the menu 
commands, and gives instructions on how to build or edit 
Web pages in outline mode. You should be familiar with 
the contents of this chapter before starting to edit HTML.

Outline Editor 
Features

The GoLive CyberStudio Outline Editor adds enhanced HTML editing 
functionality to GoLive CyberStudio, allowing you to define new tags 
still unsupported by the Layout Editor, fine-tune your code, or even 
build Web pages from scratch.

The Outline Editor uses a completely new approach to HTML editing. 
Unlike conventional editors, which display more or less raw HTML 
code, the GoLive CyberStudio Outline Editor presents the HTML back-
bone of your Web page in a clear-cut outline view.

The Outline Editor screen is shown below.

The Outline Editor Screen

GoLive CyberStudio’s Outline Editor also provides full drag & drop 
support for all Body tags from the Palette, provides for Point & Shoot 
linking, and integrates a powerful HTML tag database. 
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International script systems selected using the Encodings and Fonts 
& Scripts preferences are displayed as clear text, allowing the user to 
edit foreign-language content—for example, Japanese or Chinese 
text.

The tag database holds the complete set of HTML tags, both HTML-
standard and browser-specific. GoLive will continually update this 
database to make sure that it’s current. New database revisions will 
be made available for downloading at our http://www.golive.com 
site.

If you are keeping track of the latest developments of the HTML lan-
guage, you may also choose to add new tags to the database as they 
evolve. Editing the tag database is simple and straightforward.

User Profiles If you are a seasoned HTML programmer, you will find that the 
GoLive CyberStudio Outline Editor adds the ability to tweak and ad-
just the underlying HTML code. So, after completing the layout of 
your Web page in Layout mode, you can use the Outline Editor to 
check out the structure of and fine-tune your HTML code—for exam-
ple, by adding custom attributes. 

If you are a novice, the GoLive CyberStudio Outline Editor will allow 
you to take a close look at the “nuts and bolts” of HTML. However, 
unlike many other products, it will not confront you with raw HTML 
code. Instead, the Outline Editor will guide you through a structured 
view of your Web page, helping you to learn and understand the 
rules of Web page design much faster and easier.

Outline Editor 
Commands in Your 
GoLive CyberStudio 
Menus

Several commands in your Edit and Window menus are reserved for 
the Outline Editor. 

Outline Editor commands in the Edit menu include:

• New HTML Tag
• New HTML Text
• New HTML Comment
• New HTML Attribute
• Toggle Binary

There is only one Outline Editor command in the Window menu:

• HTML Tag Database
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The menu shots below show the location of the Outline Editor menu 
commands. For more detail and instructions on using these com-
mands, see the sections Editing HTML Code in the Outline View on 
page 320 and The HTML Tag Database on page 331.

Outline Editor Commands 
in the Edit Menu

Note that most of the Layout editor menu commands are 
dimmed after opening a document with the Outline Editor. 
Conversely, all Outline Editor commands will be dimmed when 
you open a document in Layout mode.

Launching the 
Outline Editor

To launch the Outline Editor, proceed as follows:

Click the Outline tab in the document window. 

Although launching the Outline Editor may completely disable 
the Layout mode and dim all Layout menu commands, it will 
not change the HTML code in your file.

These commands are only available in the 
outline mode. {
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Opening a New Web Page If you wish to build a Web page from scratch, proceed as follows: 

1 Choose the New command from the file menu. A new document 
named “untitled” will appear. 

2 Click the Outline tab in the document window to open the Out-
line Editor. 

The outline view displays a basic HTML file structure, complete with 
the basic HEAD and BODY tags and already expanded. You can use 
this structure as a template and fill it with your own content. 

Outline Editor - 
New Document in Outline View

While editing HTML code, you can expand or collapse any tag in the 
outline view by clicking the collapse/expand triangle to the left of the 
tag name. This triangle functions as an outline view control that al-
lows you to show or hide parts of or all of the entire structure. In the 
example shown above, clicking the trial symbol of the HTML tag 
would collapse the outline view completely, hiding the head and 
body sections from view.

Click this triangle symbol to expand or collapse 
the entire HTML outline view one tag at a time.

Click this tab rider to switch to the outline view.
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Opening an 
Existing Web Page

To open an existing Web page, proceed as follows:

1 Select the Open command from the File menu, then select the de-
sired file in the subsequent file selection dialog box.

2 Click the Outline tab in the document window to open the Out-
line Editor. 

The example below shows an existing document opened in the Out-
line Editor. Documents are always opened in a fully expanded out-
line view, allowing you to edit, insert, and delete individual tags. For 
more detail on editing, please refer to page 320.

Outline Editor - Opening an 
Existing Document

To streamline the view, you can now collapse individual tags by click-
ing their triangle symbol. 

To return to the initial view, proceed as follows:

1 Collapse the entire outline view by clicking the triangle symbol of 
the HTML container tag.

2 In the collapsed view, Option-click the triangle symbol of the 
HTML tag to expand the HTML outline with all HTML tags open. 

Click this triangle symbol to expand or collapse 
the HTML outline view one tag at a time.

Click this tab rider to switch to the outline view.



 

316 CHAPTER 10 Finding Your Way Through the Outline View

         
Finding Your Way 
Through the Outline 
View

The outline view consists of HTML tags arranged to reflect the hier-
archy of your HTML document:

Outline View Controls and Display 
Elements

Structural Elements

The GoLive CyberStudio Outline Editor uses various elements to dis-
play the structure of an HTML document. 

• HTML tags are displayed as box symbols.
• Indents are used to indicate the HTML hierarchy levels. The 

example above shows the basic structure of an HTML document: 
The HEAD and BODY elements are indented to indicate that they 
are contained in the HTML element. The HEAD element in turn 
contains a TITLE element with a text box.

• Open and close tags are connected by vertical lines to show that 
they are complementary items.

Controls

Each open HTML tag has various controls that allow you to rearrange 
the sequence of tags in your document, add content to your Web 
page, or expand and collapse your document view:

Highest level in HTML tag hierarchy.

Indents indicate lower-level tags.

Vertical lines connect open and close tags.

Drag & drop handle

Expands or collapses element or view 

Tag name text box

Shows or hides element attributes.Bounding box indicates current selection.
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• The Drag & Drop Handle on the left side of the box allows you to 
drag a tag and drop it to any location in your document. While 
you are dragging, a horizontal line will move along with the tag 
to indicate the current insertion point. You can move tags up or 
down the structure as desired, but only elements contained in 
the body section of your page will be visible to your audience. 

• The Collapse/Expand triangle to the left of the HTML tag name 
functions as an outline view control. Clicking at this arrow 
expands or collapses the element, showing or hiding further ele-
ments contained in it. 
Clicking at this triangle while holding the Option key depressed 
expands or collapses the entire outline view, showing or hiding 
all elements contained in the document.

• The HTML Tag Name is a text box. Clicking at the tag name acti-
vates the box, allowing you to enter a tag name.
Alternatively, clicking at the tag name while holding the Com-
mand key depressed will pop up a list of HTML tags to choose 
from.
The tags appearing in the popup menu represent the tag inven-
tory stored in the tag database.

• The Show/Hide Attributes Triangle to the right of the HTML tag 
name shows or hides the attributes defined for the selected ele-
ment.

Display Attributes

Selected elements are highlighted by a black bounding box.
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Using Keyboard Equivalents

You can use various keyboard equivalents to navigate through the 
outline view, expand or collapse, and edit elements.

• To move through the outline view, use the Cursor Up/Down 
keys. Cursor Up selects the item above the current selection, Cur-
sor Down the one below.

• To move through the attribute list of an element, use the Cursor 
Up/Down keys. Cursor Up selects the item above the current 
selection, Cursor Down the one below.

• To expand or collapse the currently selected tag element, press 
Return. Please note that this is only possible with binary tags, 
that is, tags always used in pairs.

• To recursively expand or collapse the currently selected tag ele-
ment, press Shift-Return. Please note that this is only possible 
with binary tags.

• To show or hide the tag attribute list, press Enter.
• To show or hide the tag attribute list, press Shift-Enter.
• To activate the next text box, press Tab. To activate the preceding 

text box, press Shift-Tab.
• To delete the current selection, use the Backspace key. 
• To activate the tag selection popup menu, Command-click the tag 

name.
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Using the Palette with 
the Outline Editor

Drag & drop support is available for items from the Body and Forms 
tabs of the Palette (for more detail on Body Tags, see The Palette on 
page 69 and following).

The Body Tags Tab of the Palette

You can drag frequently used elements from the Palette and drop 
them anywhere in your Outline Editor window, just as you would in 
the Layout mode. 

While you are dragging, a horizontal line will move along with the tag to 
indicate the current insertion point (see below).

Drag & Drop Insertion of a Table

After inserting a tag, you can edit its attributes using the text boxes 
and scrolling lists in the tag elements.

For more detail on editing tag attributes, please see Editing Tag At-
tributes on page 322.
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Editing HTML Code in 
the Outline View

There are several dedicated Outline Editor commands in the Edit 
menu. When in outline mode, you can use these commands to insert 
tags, editable text boxes, and HTML comments into your document. 

You can also add new attributes to your tags to implement non-stan-
dard features or anticipate upcoming HTML coding conventions.

Further, you can toggle between the unary and binary tag format—
that is, you can determine whether an open tag should be accompa-
nied by a close tag or not.

Inserting New HTML Tags The New HMTL Tag command inserts a blank HTML tag below the 
current selection. 

Selecting the New HTML Tag Command 
from the Edit Menu

The example below shows how your editor window may look after 
inserting a new tag.

Outline Editor Window with 
Undefined Tag

New HTML tag 
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Defining Tag Types

You should now define the type of the new tag you have just in-
serted. You may either enter a tag name directly or select one from 
the tag database.

To enter a tag name directly, proceed as follows:

1 Click the text box with the four question marks to select the tag 
name for overwriting. 

2 Enter the desired HTML tag name and press the Return key to 
confirm your entry.

To enter tags directly, you should be familiar with the capabil-
ities of the targeted browser. Bear in mind that unsupported 
tags will be ignored and interpreted as text. If you are not com-
pletely sure, we recommend the method described below.

Alternatively, to use a tag from the tag database, proceed as follows:

1 Command-click the text box with the four question marks. 

2 This will pop up a list with HTML tags to choose from (see below). 

3 Keep the mouse button depressed and drag through the popup 
menu.

4 Release the mouse button on the tag of your choice.

Outline Editor Window with Popup Tag 
Selection List

Command-clicking the tag name opens a tag list.
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Editing Tag Attributes

After defining the tag type, you may want to define tag attributes to 
fine-tune the appearance of your Web page.

Attributes control the way a tag is displayed by the browser. Many 
tags support special formatting instructions, such as element align-
ment, color, and directory paths to resource files.

In the example below, the BLOCKQUOTE tag is used. Any text 
wrapped into this tag will stand out as a separate block of text on the 
screen.

To define an attribute, proceed as follows:

1 Click the show/hide attributes triangle control to pop up a list of 
valid tag attributes to choose from (see example below). 

2 Select the desired attribute and assign a value. The tag element 
box will expand to accommodate the new attribute.

Defining a Tag Attribute

Alternatively, attributes can also be added using the menu New 
HMTL Attribute command. A detailed description of this menu com-
mand appears on page 326.

Click the show/hide attributes triangle to pop 
up the attribute list.

Drag through the popup menu to select the de-
sired attribute.

Click this triangle to pop up the values list.

Drag through the values list to select the desired 
value.
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Inserting Text The New HMTL Text command inserts a blank text box below the cur-
rent selection.

Selecting the New HTML Text Command 
from the Edit Menu

To type in text, proceed as follows:

Click the four highlighted question marks serving as placeholders 
and type to overwrite. The text wraps automatically at the border 
of the text box. 

You may enter any desired character. However, carriage returns 
and special characters will be ignored by the browser or may 
produce unexpected results. 

The example below shows how your editor window may look after 
inserting a new text box. 

Outline Editor Window 
with New Text Box

If you abandon text entry temporarily and deselect the text box, you 
may resume your work later by placing the cursor at the location 
where you stopped.

New text box
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Inserting Comments Comments give useful hints to any person who may want to edit your 
document at a later date—for example, if you intend to embed ad-
vanced features that require much background information. 

As comments are skipped by the browser when interpreting HTML 
code and building the page display, they can be placed anywhere in 
your document, even outside of the HTML tag.

To insert a comment, proceed as follows:

Choose the New HMTL Comment command from the Edit menu 
to insert a blank comment text box below the current selection.

Alternatively, you can insert the Comment icon from the Palette:

Drag the Comment icon from the Palette and drop it in your doc-
ument. While you are dragging, a horizontal line will move along 
with the icon to indicate the current insertion point.

The New HTML Comment Command and  
the Comment Icon

To type in text, proceed as follows:

Click the four highlighted question marks serving as placeholders 
and type to overwrite. The text wraps automatically at the border 
of the text box. 
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The example below shows how your editor window may appear after 
inserting a new comment text box.

Outline Editor Window with New 
Comment Text Box

The example below shows what comments in your document look 
like after editing.

Outline Editor Window with Comments

Although they appear dimmed, comments remain selectable 
and editable. To edit an existing comment, simply click the 
comment text.

New comment text box

Comment text box after editing
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Inserting Attributes The Outline Editor allows you to add and edit tag attributes.

Attributes control the way a tag is displayed by the browser. Many 
tags support special formatting instructions, such as element align-
ment, color, and directory paths to resource files.

To add a new tag attribute, proceed as follows:

1 Select the tag you wish to add an attribute to.

2 Choose the New HMTL Attribute command from the Edit menu. A 
blank attribute appears below the other tag attributes.

Selecting the New HTML Attribute 
Command from the Edit Menu

3 Type in an attribute name into the text box, overwriting the ques-
tion marks. Press the Return key to confirm you entry.

The example below shows how the body tag in your document 
structure may look after adding a new attribute.

Body Tag with Unnamed Attribute 

New Attribute (still blank)
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If you are not sure whether an attribute is valid or not, consult 
the tag database (see page 333).

4 Click the text box to the right of the name field, type in a value, 
and press the Return key to confirm your entry.

Body Tag with Named Attribute 

Tag Attribute Examples

The two examples below show what the BODY tag in your document 
structure may look like after defining the newly added attribute.

If the attribute is valid, a color box, path pointer, or similar symbol 
appears to the right of the attribute name.

If the new attribute is of the type Color, such as the color of the active 
link shown below, a color box and the Web color code appear beside 
the attribute name. Clicking on the color box will open the Color 
Picker.

Body Tag with New Color Attribute 

New Attribute Value 

Click this box to open the Color Picker.
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If the new attribute is of the type path, such as the directory path to 
the background image shown below, a path pointer appears beside 
the attribute name. 

Clicking on this path pointer will open a file selection dialog box, al-
lowing you to choose a background image file.

Body Tag with New Path Attribute 

This is the directory path to the 
selected background image.

Click this path pointer to pop up 
a file selection dialog.
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Using Point & Shoot in 
the Outline View

Just as the Layout view, GoLive CyberStudio’s Outline editor supports 
Point & Shoot linking to objects in the Project window, including 
HTML pages and media items.

Point & Shoot Linking in the Outline View

To use Point & Shoot linking in the Outline view, proceed as follows:

1 Locate the SRC attribute (or any other attribute referencing a file 
or resource) of the tag to be linked.

2 Command-click the small arrow pointing at the filename and 
path of the attribute

3 Drag to the desired HTML page or media file in the Project win-
dow and release the mouse button.
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Toggling the 
Binary Format

The Toggle Binary command toggles the binary tag format on and off. 
This command allows you to determine whether a new tag should 
have a complementary close tag or not.

Most HTML tags are binary tags, or container tags. Binary tags 
enclose their content in a pair of tags, referred to as open and 
close or start and end tags.
A few tags, however, do not need a close tag; these are called 
unary tags. One of the most frequently used unary tags is the 
IMG tag for embedding images.

Selecting the Toggle Binary Command 
from the Edit Menu

The example below shows the effect of toggling the binary tag for-
mat on and off.

Title Tag with Binary Format 
Toggled On and Off

Binary Format Toggled Off

Binary Format Toggled On
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The HTML Tag 
Database

The built-in HTML tag database comes with a complete inventory of 
HTML tags that assist Web authors in choosing the proper tags and 
attributes for the content of their pages.

Also, the HTML tag database is a basic building block that helps 
maintain the integrity of your HTML code. Whenever 
GoLive CyberStudio writes HTML code or checks the syntax, the tag 
database operates as an internal reference for correct HTML usage.

The tag database may be edited to accommodate future tags as they 
emerge on the Web scene. This feature is mission-critical for any Web 
designer who wishes to work with interactive elements, whether 
they are HTML or non-HTML.

Additionally, the tag database contains all special characters speci-
fied by ISO 8859-1 and the HTML 3.0 standard, enabling 
GoLive CyberStudio to convert user-entered special characters to the 
proper Web-specific character codes. 

An example of the tag database editor window appears below.

The Tag Database Tab of the 
Database Editor Window

The tag database provides direct assistance to authors, allowing 
them to pop up tag and attribute lists from the database when de-
fining a newly inserted tag element (see Defining Tag Types on 
page 321 for reference). 
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In addition, authors can open the database at any time and look it 
up like a reference book if they have any doubts about the proper us-
age of a tag and its attributes.

Maintaining 
Compatibility with 
the Web

The tag database holds the complete set of HTML tags, as known to 
GoLive at the time of publication. The built-in HTML tag inventory 
encompasses both HTML-standard and browser-specific tags, includ-
ing valid attributes and their values. HTML-standard tags include all 
the tags specified by the HTML 2.0 and 3.0 standard publications, 
while the term non-standard tags refers to tags used to implement 
advanced features, such as the background sound tag that 
Microsoft’s Internet Explorer uses. 

Because Hypertext Markup Language is a work still in progress, 
GoLive will continually update the content of this database. 

If you are keeping track of HTML on your own, you may choose to 
add new tags to the database as they become available. 

Alternatively, you can download database revisions from http://
www.golive.com and drop them in the Modules subfolder of your 
GoLive CyberStudio program folder, replacing the outdated database 
file. 
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Looking Up Tags and 
Special Characters in 
the Tag Database

You can open the tag database window from within any 
GoLive CyberStudio mode to look up tags and special character defi-
nitions. 

To open the tag database window and look up definitions, proceed 
as follows:

1 Select the HTML Tag Database command from the Window menu 
to open the database editor window.

The HTML Tag Database Command

2 Click the Tag Database or Special Characters tab, depending on 
what kind of information you want to look up.

3 Scroll through the Tags list box in the Tag Database tab or the 
characters list box in the Special Characters tab.

4 Select a tag or character from the list box to view its attributes 
and other options (if any). 

Options for tags include:

- The Attributes section contains all attributes valid for the se-
lected tag, as known to GoLive at the time of publication, 
along with attribute type information and default values. 

- To view special list formatting options (if any) associated with 
a particular attribute of the Enums type, select an attribute 
from the Attributes list.
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Editing the Tag 
Database

Editing the tag database is simple and straightforward. Each window 
area contains a list box and task-specific editing tools, allowing the 
user to add new tags and edit or delete existing tags from the list.

The example below demonstrates how the Tag Database tab of the 
database editor window looks after the user has added a new tag 
and edited its attributes.

Adding a New Tag 

Use the Tags list box and tag options to add, 
edit, and remove tags. {

{

{

Use the Attributes list box and attribute op-
tions to add, edit, and remove tag attributes.

Use the Enums list box and enums options to 
add, edit, and remove enum properties.
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Adding, Updating, or 
Removing Tags 

The database editor provides a convenient editing environment for 
adding, updating, or removing tags. 

The screenshot below illustrates the editing tools offered by the Tag 
Database tab and explains their respective functions.

Tag Database Editing Tools

Click here to select 
the format of the 
HTML tag.

Click here to enter the name of the new tag.

Click here to select HTML compatibility.

Click here to delete the selected tag.

Click here to add a new tag.

Click here to update after making changes.

Click here and type in a comment.

Click here to delete the selected attribute.

Click here to add a new attribute.

Click here to update after making changes.

Click here to delete the selected tag.

Click here to add a new enum.

Click here to update after making changes.

Click here to enter the name of the new attribute.

Click here to select HTML compatibility.

Click here to select the Value type.

Click here and type in a comment.

Click here to select HTML compatibility.

Click here and type in a comment.

Use these options to toggle automatic CR and tab 
insertion into the source code on and off.

Use this popup menu 
to control the way 
GoLive CyberStudio 
handles spaces be-
hind HTML elements.

Select this checkbox to 
create a HTML tag 
with protected plain-
text content.

Click here to select 
the format of the 
HTML attribute.
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Adding a Tag

To add a tag, proceed as follows:

1 Place the cursor in the Name text box in the Tags section of the 
Tag Database tab.

2 Enter the name of the new tag—for example, NEWTAG, and 
press the Return key to confirm your entry.

3 Select the desired browser or HTML standard revision option 
from the HTML compatibility popup menu—for example, 
Netscape 4.

4 Check the Plain text checkbox if you want to protect the content 
of the tag. This feature is particularly useful for non-HTML con-
tent that needs to remain unaffected when the user edits the 
HTML—for example, if a page contains dynamic WebObjects el-
ements. 

When you place the newly defined tag on a page (by inserting an 
unknown tag and selecting the new definition), the plain-text 
content is saved but not displayed—neither in Source nor in Lay-
out mode. Content viewing and editing is possible using the Con-
tent tab of the respective inspector.

5 Use the Spaces popup menu to control the behavior of tags with 
respect to white spaces. This feature lets you ensure that trailing 
tags are handled according to HTML standards. Examples from 
the tag database include:

- <P>: Neutral instructs GoLive CyberStudio to leave subse-
quent white spaces unmodified.

- <H1>: Kill Next lets GoLive CyberStudio delete a subsequent 
white space behind a header tag.

- <IMG>: Get Next lets GoLive CyberStudio read and display a 
subsequent white space.

- <APPLET>: Container lets GoLive CyberStudio read the reset 
function within the start tag and clear all white spaces up to 
the next visible object.

6 Select the desired format option from the HTML tag status popup 
menu—for example, Required.

- Choose None if you want to define a unary tag consisting of a 
start tag, attributes, and optional content.

- Choose Required to define a binary tag consisting of a start 
tag, attributes, optional content, and an end tag.
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- Choose Optional if the new tag does not necessarily need an 
end tag.

- Choose Attribute to define an attribute.

7 Place the cursor in the Comment text box and enter a comment, 
if required.

8 Check the Start Tag and End Tag padding controls to control the 
way a tag is written in HTML source code.

The screenshot below explains the functions of the individual 
buttons.

Tag Padding Controls in the 
Database Editor Window

9 Click the Add button.

Updating

To update a tag, proceed as follows:

1 Select the tag to be changed from the Tags list box.

2 Make the desired changes—for example, by selecting a new op-
tion from the compatibility popup menu.

3 Click the Update button.

Removing

To delete a tag, proceed as follows:

1 Select the tag to be deleted from the Tags list box.

2 Click the Remove button.

Click this button to have a carriage return 
inserted after the end tag.

Click this button to have a carriage return 
inserted before the end tag.

Click this button to have a tab 
inserted before the content.

Click this button to have a carriage return 
inserted before the start tag.

Click this button to have a carriage return 
inserted after the start tag.
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Adding, Updating, or 
Removing Attributes

You add, update, or remove attributes by using the text boxes, check-
boxes, popup menus, and buttons in the Attributes section of the Tag 
Database tab. 

Adding

To add an attribute, proceed as follows:

1 After selecting the tag you wish to add an attribute to, click at the 
Name text box in the Attributes section.

2 Enter the name of the new attribute—for example, NEWATT.

3 Select the desired browser or HTML standard revision option 
from the HTML compatibility popup menu—for example, 
Netscape 4.

4 Select the desired format option from the HTML attribute status 
popup menu—for example, Optional.

Choose Required if the new attribute is necessary for the browser 
to interpret the new tag properly.

5 To define the type of the default attribute value, select the desired 
option from the Value type popup menu—for example, Enum.

6 Click at the Value text box and enter a default value for the new 
attribute.

7 Place the cursor in the Comment text box and enter a comment, 
if required.

8 Click the Add button.

Updating

To update an attribute, proceed as follows:

1 Select the attribute to be changed from the Attributes list box.

2 Make the desired changes—for example, by selecting a new op-
tion from the Value popup menu.

3 Click the Update button.

Removing

To delete an attribute, proceed as follows:

1 Select the attribute to be deleted from the Attributes list box.

2 Click the Remove button.
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Adding, Updating, or 
Removing List 
Formatting Options

You add or remove list formatting options by using the text boxes, 
checkboxes, popup menus, and buttons in the Enums section of the 
Tag Database tab. 

Adding

To add a formatting option, proceed as follows:

1 After selecting the attribute to which you wish to add a format-
ting option, click at the Name text box in the Enums section.

2 Enter the name of the new formatting option—for example, 
NEWENUM.

3 Select the desired browser or HTML standard revision option 
from the HTML compatibility popup menu—for example, 
Netscape 4.

4 Click the Add button.

Updating

To update a formatting option, proceed as follows:

1 Select the formatting option to be edited from the Enums list box.

2 Make the desired changes to the formatting option—for exam-
ple, by selecting a new option from the HTML compatibility pop-
up menu.

3 Click the Update button.

Removing

To delete a formatting option, proceed as follows:

1 Select the formatting option to be deleted from the Enums list 
box.

2 Click the Remove button.
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Editing Special Characters In addition to tags, the database editor lets you edit the HTML codes 
used to ensure a uniform display of special characters across multi-
ple computer platforms. 

The example below demonstrates how the Special Characters tab of 
the database editor window looks after the user has added a new 
character.

Adding a New Character 

Scroll the list box to view its content or click to 
select a character.

{Use these options to add, edit, and remove 
special characters.
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Adding, Updating, or 
Removing Special 
Characters

The database editor provides a convenient editing environment for 
special characters. 

The screenshot below illustrates the editing tools offered by the Spe-
cial Characters tab and explains their respective functions.

Character Editing Tools

You add, update, or remove special characters by using the text 
boxes, popup menus, and buttons at the bottom of the Special 
Characters tab. 

Adding

To add a special character, proceed as follows:

1 Enter the name of the new character in the Name text box and 
press the Return key to confirm your entry.

2 Place the cursor in the Value text box and enter a character from 
the keyboard or a known character code—for example, a three-
digit or four-digit number with a leading pound sign. 

If you enter new ISO 8859-1 characters, you don’t need to type in 
the HTML code with the leading ampersand and trailing semico-
lon.

3 Select the desired browser or HTML standard revision option 
from the HTML compatibility popup menu—for example, 
Netscape 4.

4 Place the cursor in the Comment text box and enter a comment, 
if required.

5 Click the Add button.

Click here to enter the name of the new character.

Click here to select HTML compatibility.

Click here to delete the selected character.

Click here to update after making changes.

Click here to add a new character.

Click here to type in a comment.

Click here to enter a value.
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Updating

To update a special character, proceed as follows:

1 Select the special character to be changed from the list box.

2 Make the desired changes—for example, by entering a new code 
in the Value text box.

3 Click the Update button.

Removing

To delete a special character, proceed as follows:

1 Select the special character to be deleted from the list box.

2 Click the Remove button.
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